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Welcome Screen

Welcome to Adams View Start Screen
Adams View is a powerful modeling and simulating environment. You can use Adams View to build and 
simulate a model of any mechanical system that has moving parts. You can test your model in the same 
environments your actual product will experience. You can also validate your model against test data, and 
refine your model with flexible parts, realistic geometry, and controls. Finally, you can find the important 
parameters that affect your product design and find the right combination of design values to arrive at the 
best product design. Best of all, you can do all this over and over again, saving time and money.

With the Adams 2012 release, the updated Graphical User Interface (GUI) introduced. This includes changes 
to the Start Screen where you are provided with the option to create new model or import an existing model.
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New Model

To create a new model, select the New Model icon  from the start screen. You will be presented a panel 
which consist of options needed to create a new model.

You can change the working directory by clicking the Browse For Folder  button.

Existing Model

To start your Adams session from an existing model, select the Existing Model icon  from the start 

screen. 

You can browse for the model by clicking the Existing Model  button in the opened dialog box or you 

can right click inside the File Name field and locate the existing model through the Browse option.
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Contents of This Guide
This guide provides overview information and step-by-step procedures for building, simulating, and refining 
a model using Adams View. You will solve an actual design problem, construct a hand latch for closing large 
containers. In the process, you will learn how to use the features of Adams View to solve your own design 
problems, from concept to finished product. 

Additional tutorials are available online for additional modules, such as Adams Flex, and Adams Controls.
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Introducing the Latch Design Problem

Overview
This tutorial introduces you to the process of solving an engineering design problem using Adams View. 

We assume that you will work through this tutorial in sequential order. Therefore, we give you more guidance 
in the beginning and less as you proceed through the tutorial. If you choose not to work through the tutorial 
in sequential order, you can import command files into Adams View at different points in the tutorial and 
start working from there. You may, however, have to reference the beginning chapters for some of the basic 
concepts. 

Look for the merge symbol at the beginning of each chapter to find out which file to import.

This chapter contains the following sections:

 What You Will Learn

 What You Will Create

What You Will Learn
The tutorial leads you through the design process steps outlined in Figure 1. These are the four basic steps you 
should follow whenever you use Adams View to create and test models:

Build a model by:
 Including moving parts, joints, flexible connections, and applied forces.

Test your design by:
 Performing simulations as you build up your model.
 Simulating the motion of the model as it would perform in actual operation. 

Review your test by:
 Viewing the results of the simulations.
 Comparing physical test data with the results of the virtual simulation.

Note:  By default on Windows, files in the installation directory are read-only. During installation, 
your system administration can choose to change the permissions so you can write to the 
installation directory. If this has not been done, you need to change the permissions of the 
files when you copy them to your working directory.
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Improve your model by:
 Refining your model so your virtual test data matches your physical test data.
 Iterating your design to assess the sensitivity of its performance to various design changes.
 Optimizing your design to find the best combination of design parameters to achieve maximum 

performance.

Finally, you can automate the design process steps so you can quickly evaluate various design options.

Figure 1  Design Process Steps for the Latch Model

Build
Construct and connect four latch parts

Verify that parts and connections have been created properly

Review

Test

Improve

Automate

 

Construct test environment

Instrument the model with measures of clamping force and toggle angle

Apply proper input loads

Plot clamping force versus angle of handle

Import test data to compare with simulation data

Refine

Parameterize the critical point locations
Iterate:
Study the effect of moving the pivot base on the clamping force
Find sensitivity of clamping force to movements in any critical point
Optimize
Maximize clamping force by moving critical point locations
Ensure the latch toggles properly
Ensure mechanism stays within envelope

Create various handle force magnitudes
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What You Will Create 
In this tutorial, you will build a latch model that is required to securely clamp two halves of large shipping 
containers together. The latch design problem is based on a latch developed by Earl V. Holman of North 
American Aviation, Inc., Downey, CA, under contract to the Manned Spacecraft Center in Houston. This 
latch is one of twelve used to clamp the Lunar Excursion Module to the Command and Service Module in 
the Apollo program. 

Figure 2 shows an illustration of the physical model of the latch.

Figure 2  Physical Model of Hand Latch Design
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Design Requirements
The latch model must meet the following design requirements:

 Exerts at least 800 N clamping force.
 Is hand-actuated by less than 80 N force.
 Is hand released with minimal effort.
 Must work within a given envelope.
 Clamping remains secure under vibration.

How the Latch Model Works
Figure 3 shows a virtual model of the latch. The latch is clamped by pushing down on the operating handle at 
POINT_4. This causes the pivot to rotate around POINT_1 in a clockwise direction, drawing back POINT_2 
of the hook. As this happens, POINT_8 of the slider is forced downward. Finally, as POINT_8 passes through 
the line between POINT_9 and POINT_3, the clamping force reaches its maximum. POINT_8 should move 
below the line created by POINT_3 and POINT_9, followed by the operating handle coming to rest on the 
top of the hook. This sets the latch near the maximum force point, but allows a reasonable release force to 
open the latch. 
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Figure 3  Adams View Latch Model

Based on the description of the latch operation, the relative layout of POINT_1 through POINT_9 is 
important in ensuring that the latch will meet the design requirements. Therefore, when your latch model is 
assembled and tested, you need to change the relative locations of the points to see their effect on the design 
requirements.
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Building Your Model

Overview
In this chapter you build and connect the parts of the toggle latch. You also verify that, you have created parts 
and connections properly. Once you have a valid model, you will proceed to test it in a realistic situation, as 
explained in Testing Your First Prototype. 

Adams View assigns to the parts you create the material type of steel, with a material density of 7801.0 kg/m3.

You build the latch model in two basic sections:

 Building the Pivot and Handle

 Building the Hook and Slider

Figure 1 shows the latch as it should look when you have finished it.

Figure 1  Latch in Build Phase
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Building the Pivot and Handle
As the initial steps in building the latch model, you perform the following tasks:

 Starting Adams View and Creating a Database

 Familiarizing Yourself with Adams View

 Setting Up Your Work Environment

 Creating Design Points

 Creating the Pivot

 Renaming the Pivot

 Creating the Handle

 Connecting the Parts Using Revolute Joints 

 Simulating the Motion of Your Model

 Seeing the Effect of Parameterization

Starting Adams View and Creating a Database
In this section, you start Adams View and create a modeling database containing a new model named Latch. 
A modeling database contains all your work in the current session of Adams View. It contains any models you 
create, their attributes, simulation results, plots, customized menus and dialog boxes, and any preferences you 
set.

In the Linux environment you start Adams View from the Adams Toolbar. In the Windows environment you 
start Adams View from the Start button.

To start Adams View in the Linux environment:
1. At the command prompt, enter the command to start the Adams Toolbar, and then press Enter. The 

standard command that MSC Software provides is adamsx, where x is the version number, for 
example adams2022_3. 

The Adams Toolbar appears.

2. Select the Adams View tool .

The Welcome dialog box appears on top of the Adams View main window.

To start Adams View in the Windows environment:
1. Select Start.

2. Point to Programs, point to Adams 2022.3, and then select Adams View. 

The Welcome dialog box appears.

To create a database from the Welcome dialog box:
1. Select Create a new model.
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2. Replace the contents of the Model name text box with Latch.

3. Select OK.

Familiarizing Yourself with Adams View 
Before continuing with the tutorial, familiarize yourself with the Adams View interface. In particular, ribbon 
based tabbed icon containers, see section Ribbon Capability for more information.

Figure 2  Adams View interface

Learning About Getting Help
When working in Adams View, you can get help in a number of ways:

 Use the online help to read overviews, procedures, and see many examples. From the Help menu, 
select Adams View Help.
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 Use the dialog box help to learn about entering values in a dialog box or using an Adams View tool. 
While working in a dialog box, press the F1 key.

For more information about getting help in Adams View, see the printed Release Guide that comes with your 
license. 

Setting Up Your Work Environment
In this section you set your units, specify the grid size, and display the coordinate window. You can change 
the units at any time during the modeling process, even while reading and writing model or results data files. 
You can use the Adams View working grid and the coordinate window to establish map points and receive 
feedback on precise locations for the design layout.

To set up your work environment:
1. From the Settings menu, select Units.

The Units Settings dialog box appears.

2. Set the units of length to centimeter.

3. Select OK.

4. From the Settings menu, select Working Grid.

The Working Grid Settings dialog box appears. 

5. Set the grid size along X and Y to 25, and the grid spacing for X and Y to 1

6. Select OK.

7. From the Settings menu, select Icons.

Note:  You do not need to enter units because Adams View uses the default units if you do 
not specify them. However, because you set the units to centimeters earlier, ensure that 
you do not enter mm after the values in the Size and Spacing text boxes.
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The Icon Settings dialog box appears.

8. In the New Size text box, enter 1.5.

9. Near the bottom of the Icon Settings dialog box set Name Visibility to On. 

10. Select OK.

To display the Coordinates window:
1. From the View menu, select Coordinate Window.

The Coordinates window appears.

2. Move your cursor around the screen and notice the coordinate location labels that appear in the 
Coordinates window and next to the cursor.

During this tutorial, you will find it very helpful to have the Coordinates window open because you will place 
many objects based on their coordinate location. 

Creating Design Points
Adams View enables you to change the layout of your design to quickly find the best mechanism for the 
application. You use points to lay out your design so that you can make layout changes by moving the points. 
Points are used to define locations in space on which you can position and parameterize other objects. Points 
are the easiest way to parameterize the geometry of a model because they let you specify important locations 
once and build other modeling objects from them. Parameterization becomes important later on when you 
work on refining your latch model.

To create design points:

1. From the Main menu, select the Dynamic Pick tool  to zoom in on your grid. 

2. Drag the cursor across the area of the working grid display.

3. Click the Bodies tab on the Adams View ribbon.

4. From the Construction container, click the Point tool  and click the locations shown in Table 1 
to place design points. Use the default settings for point, which are Add to Ground and Don’t Attach.

Note:  The text box New Size is colored gray. Throughout Adams View gray text boxes 
means that the text box is optional and you do not have to enter a value to execute the 
command. 

Note:  To create multiple points without having to select the Point tool again, double-click 
the tool. To deselect the Point tool, select the Select tool.
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Creating the Pivot
Create the pivot using the Plate tool. The pivot represents the pivot part, as shown in Figure 1.

To create the pivot:
1. Click the Bodies tab on the Adams View ribbon.

2. From the Solids container, click the Plate tool . 

3. In the Main toolbox, in the Thickness text box, enter 1, and then press Enter.

4. In the Radius text box, enter 1, and then press Enter.

5. Click the location of POINT_1, POINT_2, and POINT_3.

6. Right-click to stop selecting points and create the pivot geometry.

Renaming the Pivot
As you create objects, Adams View automatically assigns names to them. Each name consists of a string 
containing the object type and a unique integer ID for that type. For example, Adams View named the 
recently created part PART_2.

The full name of an object is comprised of the concatenated names of its parent similar to a directory 
structure in a file system. Because PART_2 is located within the model named Latch, its full name is 
.Latch.PART_2, while the full name of the marker named cm on PART_2 is .Latch.PART_2.cm. 

In this section, you rename PART_2 to pivot. Adams View understands that you are just renaming the part, 
so the model name Latch remains.

Table 1  Points Coordinate Locations

X location: Y location: Z location:

POINT_1 0 0 0

POINT_2 3 3 0

POINT_3 2 8 0

POINT_4 -10 22 0

Note:  Pressing Enter every time you enter text into a text box ensures that Adams View 
accepts the entered value.

Note:  The Adams View status bar provides instructions on how to perform operations. 
When you move your cursor on the screen during an operation, the status bar 
displays what you should do next. The status bar is located below the Adams View 
main window. For the location of the status bar, see Figure 1.
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To rename the pivot:
1. Right-click the plate part. 

A shortcut menu appears. 

2. Point to Part: PART_2, and then select Rename. 

The Rename Object dialog box appears.

3. Replace PART_2 with pivot, as shown in the following dialog box: 

Creating the Handle
You can create the handle using the Link tool .

To create the handle:
1. Click the Bodies tab on the Adams View ribbon.

2. From the Solids container, select the Link tool .

3. Click POINT_3, then POINT_4 to create a link between the two points. 

4. Rename the link part, Part: PART_3, to handle, to represent the handle part as shown in Figure 1.

Connecting the Parts Using Revolute Joints
A revolute joint is an attachment between two parts that allows one part to move with respect to another part 
about a common axis.

In this section, you place a revolute joint between the pivot and ground, which will allow the pivot to rotate 
with respect to ground. You also place a second revolute joint between the pivot and handle to allow the two 
parts to rotate with respect to each other. 

You will use the construction method 2 Bod - 1 Loc, and Normal To Grid to create the revolute joints, which 
is the default method. When you use this method for creating revolute joints, you select the two bodies to 
attach and then select the location.

Note:  Only attach the link to a point when that point label is visible.
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To connect the parts using revolute joints:
1. Click the Connectors tab on the Adams View ribbon.

2. From the Joints container, select the Revolute Joint tool .

3. To select the parts to attach, click the pivot and ground (the background). 

4. Click POINT_1 to set the joint’s location. 

The revolute joint at POINT_1 should look like this:

 

5. Select the Revolute Joint tool again.

6. Select the pivot, the handle, and POINT_3. 

Simulating the Motion of Your Model
In this section you set the simulation parameters, and simulate the motion of the model to see if you have 
assembled the parts and joints properly. You set the simulation end time and the number of output steps to 
tell Adams View how long you want the simulation to run, and the frequency with which you want it to 
output the data. 

During the simulation, the handle moves in a circular motion with respect to the pivot, as the pivot moves 
in a circular motion with respect to ground. Note that gravity is acting on the model. 

To simulate the motion of your model:
1. Click the Simulation tab on the Adams View ribbon.

Note:  If you did not change the icon size as explained in Step 7. in Setting Up Your Work 
Environment, you will not see the revolute joint on the screen. Go back and change the 
icon size as explained in Step 7. In the Icon Settings dialog box, be careful not to 
accidentally turn off the display of icons. 
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2. From the Simulate container, click the Simulate tool .

3. Set up a simulation with an end time of 1 second and 50 steps.

4. Select the Simulation Start tool . 

The model simulates, and then remains in simulate mode.

5. To return to the initial model configuration, select the Reset tool .

At this step in the creation of the latch, the model is effectively a double pendulum falling due to the 
influence of gravity. This illustrates one of the advantages of interactive model building. Namely, that 
you can interrogate the behavior of the model even though the model is not complete. 

Seeing the Effect of Parameterization
Since you parameterized your latch model using points, you can move a point and the related objects update 
automatically. For example, if you move POINT_1, the pivot and the joint move along with it since they were 
created on top of that point.

To see the effect of parameterization:
1. Right-click POINT_1.

A shortcut menu appears.

2. Point to Point: POINT_1, and then select Modify. 

The Table Editor appears, listing the points in your model and their locations.

3. Set the x location for POINT_1 to -2.

4. Near the top right corner of the Table Editor, select Apply.

POINT_1, along with the joint and the pivot, move to the new location.

5. Set the x location for POINT_1 back to 0.

6. Select OK. 

Building the Hook and Slider
The last steps in building the geometry of the latch model are:

 Creating the Hook and the Slider

 Connecting the Parts Using Revolute Joints

 Simulating Your Model

Note:  You can move the Table Editor out of the way by clicking and dragging its top window 
border.
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 Saving Your Database

Creating the Hook and the Slider
You now create the hook using the Extrusion tool. An extrusion is a three-dimensional object defined by its 
profile and depth. To create an extrusion, you draw a polyline that defines the extrusion’s profile. By default, 
Adams View extrudes the profile along a line perpendicular to the working grid.

To create the hook:
1. Click the Bodies tab on the Adams View ribbon.

2. From the Solids container, click the Extrusion tool .

3. Be sure that Create profile by: is set to Points and Closed is selected. 

4. Select Path: to About Center.

5. In the Length text box, enter 1, and then press Enter.

6. Click the locations listed in Table 2. 

7. To close the extrusion, right-click.

Small boxes, called hot points, appear at the vertices of the extrusion.

Note:  Sometimes Adams View snaps to the nearest object instead of snapping to a 
coordinate value. To override this, hold down the Ctrl key and move the cursor until 
you select the desired coordinate.

Table 2  Extrusion Coordinate Values

X location: Y location: Z location:

5 3 0

3 5 0

-6 6 0

-14 6 0

-15 5 0

-15 3 0

-14 1 0

-12 1 0

-12 3 0

-5 3 0

4 2 0
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8. Right-click to stop selecting locations and create the geometry. 

9. Rename the extrusion part to hook.

To create the slider:
1. Create two more design points, POINT_8 and POINT_8_2, at the locations shown in Table 3.

2. Create a link connecting these two new design points. Again, before you click, make sure the point 
labels are visible.

3. Rename the link part to slider.

Connecting the Parts Using Revolute Joints
You now create three more revolute joints.

 Place revolute joints at the following locations using the construction method 2 Bod - 1 Loc, and 
Normal To Grid:

• Between the handle and the slider at POINT_8.

• Between the slider and the hook at POINT_8_2.

• Between the hook and the pivot at POINT_2.

Simulating Your Model
In this section you simulate again to see if you have assembled the parts and joints properly. During this 
simulation, the handle, the hook, and the slider move in a circular motion with respect to the pivot, as the 

Note:  If you make a mistake while creating the extrusion, continue creating the extrusion, 
and then, at the end, use the extrusion hot points to place the points in the correct 
locations. You can also use the Undo tool  to cancel any of the changes you made. 
You can undo up to 10 actions.

Table 3  Points Coordinate Locations

X location: Y location: Z location:

POINT_8 -1 10 0
POINT_8_2 -6 5 0

Tip: You can see the names of objects that are in the same location by right-clicking on the 
objects. A shortcut menu appears with the names of all the objects at that location. 
This is also helpful if you have forgotten the names of objects. 
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pivot moves in a circular motion with respect to ground. The only force acting on this model is gravity, since 
you have not assigned any forces to it. 

To simulate the motion of your model:
1. Select the Simulation tool.

2. Run a .2 second, 200-step simulation. 

3. Select the Reset tool to return to the initial model configuration.

Saving Your Database
Use the Save Database As command to save the current modeling database as an Adams View binary file. 
Saving your modeling database as a binary file saves all modeling information.

To save your database:
 From the File menu, select Save Database As, and then save the file as build.
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Testing Your First Prototype

Overview
In this chapter, you prepare the latch model for virtual testing, and then proceed to test it. Virtual tests allow 
you to quickly set up and tear down tests in the virtual environment. 

In the test phase you will be doing the following:

 Creating the Ground Block 

 Adding a Three-Dimensional Contact

 Adding a Spring

 Creating a Handle Force

 Creating a Measure on the Spring Force

 Creating an Angle Measure

 Creating a Sensor

 Saving Your Model

 Simulating Your Model

If you choose not to work through the tutorial in sequential order and want to start here, import 
the file build.cmd from install_dir/aview/examples/Latch/, where install_dir is the 
directory where Adams is installed.  

Figure 1 shows how your model should look at the end of the test phase.
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Figure 1  Latch Model in Test Phase

Creating the Ground Block
You use the Box tool to create a ground block. The ground block represents the surface on which the hook 
slides. By default, Adams View creates the block with a depth that is twice the length of the shortest 
dimension of the block. You can also specify the length, height, and depth of the block before you draw it. 

To create the ground_block:
1. Click the Bodies tab on the Adams View ribbon.

2. From the Solids container, select the Box tool , and change its construction method from New 
Part to On Ground.

3. Click at location (-2, 1, 0) and drag to (-18, -1, 0). Alternatively, you can click at the start location 
and then click again at the end location.

4. Rename the part ground to ground_block.
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Adding a Three-Dimensional Contact
In this section, you add a three-dimensional contact between the hook and ground_block. The three-
dimensional contact models how hook and ground_block interact when the latch closes. 

To add a three-dimensional contact:
1. Click the Forces tab on the Adams View ribbon.

2. From Special Forces container, click the Contact tool . 

The Create Contact dialog box appears. 

3. Right-click the I Solid text box, point to Contact_Solid, and then select Pick. Select the hook 
(EXTRUSION_7). 

4. Now do the same for the J Solid text box, selecting the ground_block (BOX_10). 

5. Because you will use the default values for the contact force, select OK. 

6. From the main menu, select the Fit tool .

Adams View fits your entire model into the current window. It should look similar to the one shown 
below: 
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Adding a Spring
The spring between the hook and ground represents the clamping force when the hook engages the container. 

The spring should have a stiffness coefficient of 800 N/cm and a damping coefficient of 0.5 , so that a 

hook movement of 1.0 cm gives a large clamping force.

As you create the spring, Adams View automatically creates markers to define the location and orientation of 
the spring. Because the hook vertex is not in the plane of the model, after you create the spring, you should 
modify the marker at the vertex so the spring is in the plane of the model.

N s
cm

-----------
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To add a spring:

1. From the main menu, click the Dynamic Translate tool  to move your model to the right, to give 
yourself room to add the spring.

2. Click the Forces tab on the Adams View ribbon.

3. From the Flexible Connections container, click the Translational Spring-Damper tool  to create 
a spring between the ground and the hook. 

4. Set K to 800 and C to 0.5.

5. To add the spring, click at the following locations:

• Hook vertex, .HOOK.EXTRUSION_7.V16, near location (-14, 1, 0), making sure to select the 
vertex and not a point near it. 

• (-23, 1, 0)

A red spring appears.

To modify a marker:
1. Right-click the location (-14, 1, 0).

A shortcut menu appears.

2. Point to Marker: MARKER_24, and then select Modify.

The Marker Modify dialog box appears.

Tip: To ensure that you select the hook vertex, right-click with the cursor near the vertex 
location (-14,1,0). A select list appears with all the vertices in the area. Select vertex 16.
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3. In the Location text box, change the location to (-14.0, 1.0, 0.0).

Adams View puts the spring in the plane of the model.

4. Select OK.

5. Use the View Fit tool  to fit your model to the screen.

Creating a Handle Force
In this section you create a handle force with a magnitude of 80N, representing a reasonable force to be 
applied by hand.

To create a handle force:
1. Click the Forces tab on the Adams View ribbon.

2. From the Applied Forces container, click the Force (Single-Component) tool .

• Set Run-time Direction to Space Fixed.

• Set the Characteristic to Constant.

• Select Force, and then set it to 80.

3. Select the following in the order listed:

• The handle

• A marker near POINT_4, the handle end point

• The location -18, 14, 0

Adams View creates a handle force.

Creating a Measure on the Spring Force
Adams View uses measures to monitor important model characteristics during simulation. To give you visual 
feedback on the progress of the simulation during interactive simulations, Adams View displays the measure 
values.

For the latch model, you need a measurement of the clamping force when the latch is clamped so you can 
compare it with the design requirement. The spring force measure represents the clamping force.

To create a measure on the spring force:
1. Right-click the spring, point to Spring: SPRING_1, and then select Measure.

The AssemblyMeasure dialog box appears.

Note:  The Marker name could be MARKER_26, if you have worked the tutorial from the 
beginning rather than starting from a cmd file. 
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2. Set Characteristic to force.

3. Select OK.

The spring measure strip chart appears.

4. Run a 0.2 second, 50-step simulation.

A graph of the clamping force appears during the simulation, as shown next:

 

5. Select the Reset tool to return to the initial model configuration.

Creating an Angle Measure
Now you create an angle measure to ensure that the handle pushes down far enough to engage the latch. 
When the latch engages, you know that the handle has toggled “overcenter” and is now capable of holding 
the latch in a secure position. It’s similar to using vice grips--the point where the vice clamps down on the 
material is the toggle point.

Creating the angle measure involves picking markers located at the points defining the angle, in this case 
POINT_8, POINT_3, and POINT_8_2. Adams View automatically defines markers at the center of mass of 
all parts and at vertices and endpoints of geometry. Adams View also creates markers automatically when you 
constrain objects, like when you add a joint between parts. Therefore, there can be several markers at one 
location. When you create the angle measure you only need to pick one marker for each location. However, 
you must make sure that the marker you pick belongs to the appropriate part.

To create an angle measure:
1. Click the Design Exploration tab on the Adams View ribbon.

2. From the Measures container, click Angle Measure tool . Click Advanced button.

The Angle Measure dialog box appears.

3. In the Measure Name text box, enter the measure name as overcenter_angle.

4. Right-click the First Marker text box, point to Marker, and then select Pick.
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5. Pick the markers to enter in your measure as shown in row 1 of Table 1 and illustrated in Figure 2.

6. Repeat the above two steps for the Middle Marker and Last Marker

.

Figure 2  Graphical Representation of overcenter_angle

7. Select OK to display your angle measure strip chart as shown next:

Note:  Do not pick markers that belong to ground, because markers used in the angle measure 
must move with the latch.

Table 1  overcenter_angle Measure Markers

Angle points: Marker location: Coordinate values:

First Point Any marker at POINT_8 -1, 10, 0

Middle Point Any marker at POINT_3 
(angle vertex)

2, 8, 0

Last Point Any marker at POINT_8_2 -6, 5, 0

POINT_8_2

POINT_8

POINT_3

(-1, 10, 0)

  (2,8,0)

 (-6,5,0)
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Creating a Sensor
You now create a sensor to detect when overcenter_angle goes below zero, meaning that the latch has toggled 
properly. When this condition is met, the sensor automatically stops the simulation.

To create a sensor:
1. Click the Design Exploration tab on the Adams View ribbon.

2. From the Instrumentation container, click Sensor  icon.

The Create Sensor dialog box appears.

3. Modify the Create Sensor dialog box as shown next, and then select OK.
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Saving Your Model
Save your latch model to record your progress.

To save your model:
 From the File menu, select Save Database As, and then save this file as test.

Note:  If you get an error when trying to create the sensor, type in a new name for the sensor, press 
Enter, and then continue filling in the dialog box as shown above.



39Testing Your First Prototype
Simulating Your Model

Simulating Your Model
Simulate your model to see if it is assembled properly and that the sensor works to stop the simulation when 
the overcenter_angle measure becomes less than or equal to 0, indicating that the latch has reached its toggle 
point.

To simulate your model:
1. Select the Simulation tool and run a 0.2-second simulation with 100 steps.

As the simulation proceeds, Adams View updates the strip charts for the spring force and angle 
measures to show that the sensor stopped the simulation. 

A message window also appears alerting you that Adams View stopped the simulation because of the 
sensor.

These strip charts show that Adams View stopped the simulation as the latch reached the toggle point:

 

2. Select the Reset tool to return to the initial model configuration.
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Reviewing Results Against Physical 
Test Data

Overview
In this chapter, you compare physical test data with virtual test data. By comparing the two sets of data, you 
immediately know the limitations of your model compared to the physical prototype, and you will have all 
the data in one place to be able to eliminate the differences.

Validating against your physical test data involves:

 Importing Physical Test Data

 Creating a Plot Using Physical Test Data

 Modifying Your Plot Layout

 Creating a Plot Using Virtual Test Data 

 Saving Your Model 

If you choose not to work through the tutorial in sequential order and want to work through it 
starting here, import the file test.cmd from install_dir/aview/examples/Latch/, where 
install_dir is the directory where Adams is installed. After importing test.cmd, simulate your 
model as shown in Simulating Your Model.

Importing Physical Test Data
In this section you import physical test data to compare with your virtual test data. We created the physical 
test data by setting the overcenter_angle on a physical model and measuring the clamping force. Adams View 
takes the physical test data and creates two measures. One measure, MEA_1, contains the x data and the other 
measure, MEA_2, contains the y data for your plot. 

To import physical test data:
1. From the File menu, select Import.

The File Import dialog box appears.

2. Set the File Type to Test Data.

3. Make sure that the Create Measures option is selected.

4. Right-click the File to Read text box, point to Search, and then select $aview_dir/examples/Latch. 
From the File Selection dialog box, select test_dat.csv.

5. In the text box to the right of the Model Name menu, enter .Latch.

6. Select OK.

Note:  Because this is test data, nothing appears on the screen when you import the data.
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Creating a Plot Using Physical Test Data
You can now take the two measures created by your physical data, and use them to create a plot for 
comparison.

To create a plot using physical test data:
1. Click the Results tab on the Adams View ribbon.

2. From the Postprocessor container, click Postprocessor tool  or press F8. 

Adams View launches Adams PostProcessor (see Figure 1), a post-processing tool that lets you view the 
results of simulations you performed. Adams PostProcessor has several modes, including plotting 
(default), animation, and report, as shown in the first pull-down menu on the menu toolbar.

Take a minute to familiarize yourself with Adams PostProcessor. For more information, see the 
Adams PostProcessor online help. 

Figure 1  Adams PostProcessor

3. At the bottom left of the dashboard, set Source to Measures.

4. From the Simulation list, select test_dat.

5. At the bottom right of the dashboard, set Independent Axis to Data.

A browser, named Independent Axis Browser, appears. It lets you select data for the horizontal axis.

6. Select MEA_1.

7. Select OK.

8. From the dashboard, from the Measure list, select MEA_2, for the vertical axis data.

9. Select Add Curves to add the new data to the plot.

Adams PostProcessor displays the plot of x against y as shown next:
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.

Modifying Your Plot Layout
To make your plot ready for a report, you assign a title to the plot, assign units to the x- and y-axis, and modify 
the plot legend.

To assign units:
1. From the treeview, double-click page_1. 

2. Select plot_1.

3. In the property editor, under the tab General, clear the selection of Auto Title. 

4. In the Title text box, enter Latch Force vs. Handle Angle.

5. Press Enter. 

6. From the treeview, double-click plot_1.

7. From the treeview, select haxis.

8. In the property editor, select the tab Labels.

9. In the Label text box, enter Degrees, and then press Enter.

10. Repeat the procedure for vaxis, labeling it Newtons.
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To modify the plot legend:
1. From the treeview, select curve_1.

2. In the Legend text box, enter Physical Test Data, and then press Enter.

Your plot should look similar to the one shown next:

Creating a Plot Using Virtual Test Data
Use the overcenter_angle and the SPRING_1_MEA_1 measures to create a plot of your virtual test data, to 
use in your comparison. After you examine your plots, you will see that the physical test data is not exactly 
the same as the virtual test data. The data is in close agreement, however. 

To create a plot using virtual test data:
1. In the dashboard, from the Simulation list, select Last_Run (...).

2. Set Independent Axis to Data.

The Independent Axis Browser appears.

3. Select overcenter_angle, for the horizontal axis data.

4. Select OK.

5. From the Measure list, select SPRING_1_MEA_1, for the vertical axis data.

6. Select Add Curves.

Note:  In case the Independent Axis browser does not appear, set the Independent Data to 
"Time" and then back to "Data".
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7. Change the legend text for this curve (curve_2) to Virtual Test Data. 

 

8. From the File menu, select Close Plot Window.

Saving Your Model

To save your model:
 From the File menu, select Save Database As, and then save the file as validate.
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Improving Your Design

Overview
In this chapter you refine your model to add more parametrics to the critical point locations. This allows you 
to compare different layouts of the model to the clamping force. 

To add more parametrics you will perform two tasks:

 Creating Design Variables

 Reviewing Design Variable Values

If you choose not to work through the tutorial in sequential order and want to work through it 
starting here, import the file test.cmd from install_dir/aview/examples/Latch/, where 
install_dir is the directory where Adams is installed.

Creating Design Variables
You now create design variables to represent the design points in your model, except for POINT_4, the handle 
end point. You do not modify POINT_4, because doing so would not meet envelope requirements for the 
mechanism. In subsequent chapters you will use design variables to run design studies and optimization.

To create design variables:
1. Right-click the design point POINT_1 (0, 0, 0), point to Point: POINT_1, and then select Modify.

The Table Editor appears.

2. To set the display of the Table Editor, click any cell other than the top left cell. 

3. Now, double-click the Loc_X cell for POINT_1. 

4. Right-click the input box at the top of the Table Editor, point to Parameterize, point to Create 
Design Variable, and then select Real.

This creates a design variable named .Latch.DV_1 with the value of 0.

5. Select the Loc_Y cell for POINT_1.

6. Repeat Step 4.

7. Repeat the above procedure for the x and y locations of POINT_2, POINT_3, POINT_8, and 
POINT_8_2. Your Table Editor dialog box should look like the one shown here:
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8. Select Apply.

Design variables now control the locations of your design points, with the exception of the POINT_4 
location.

Reviewing Design Variable Values
After you have created all the design variables, you can display their range and allowed values. Adams View 
sets the design variable range based on the envelope requirements for the latch. It automatically assigns a +/- 
10% relative range to the design variables, except when the design variable real value is 0. When the design 
variable value is 0, the range is set as +/- 1 absolute. 

If you want to open up the range to different values, you must modify the range values and possibly the delta 
type (which you will do in Iterating Your Design). This restricts the layout changes to your model, to keep it 
within a specified envelope.

To review design variable values:
1. At the bottom of the Table Editor, select the Variables option.

2. Select Filters.

The Variables Table Editor Filters dialog box appears.

Note:  Make sure your design variable names map to the design point locations, as shown 
above. This becomes important later on as you perform your design study and 
optimization.
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3. Select Delta Type.

The delta type lets you know if the range value is absolute or percent relative.

4. Be sure that Range is selected.

5. Select OK.

The Table Editor changes to show you the range of the design variables.

6. Select OK.

7. Save your the modeling database as refine.
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Iterating Your Design

Overview
In this chapter, you work on arriving at an improved design that meets the specifications and includes all 
necessary behavior of the physical latch. You set up some design studies for a few points to find a case that 
maximizes peak clamping force, while making sure the handle toggles overcenter.

In the process of iterating your design you will be:

 Performing a Manual Study

 Running a Design Study

 Examining the Results of Design Studies

If you choose not to work through the tutorial in sequential order and want to work through it 
starting here, import the file refine.cmd from install_dir/aview/examples/Latch/, where 
install_dir is the directory where Adams is installed.

Performing a Manual Study
As you perform this manual study, you will see how your spring force increases as you manually modify the 
design variable DV_1. If the spring force strip chart is not displayed, you should display it before modifying 
your design variable.

To update your spring force strip chart:
1. Click the Design Exploration tab on the Adams View ribbon.

2. From the Measures container, click Display a Measure tool . 

The Database Navigator appears.

3. Select SPRING_1_MEA_1.

4. Select OK.

5. Run a .2 second, 100-step simulation and then return to the initial model configuration.

Adams View updates the spring measure strip chart.

6. Right-click the spring force curve in the strip chart. Point to Curve: Current, and then select Save 
Curve.

To modify a design variable:
1. From the Model Browser window, click Design Variables and expand.

2. Select DV_1 from the list, right click and select Modify.
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The Modify Design Variable dialog box appears.

3. Change the standard value of DV_1 to 1.0.

4. Select OK.

5. Run a .2 second, 100-step simulation.

This new plot shows a comparison of the spring force measure for the two cases. The new curve shows 
better draw on the spring.

6. Change DV_1 back to 0.0, its original value.

Running a Design Study
Run a design study to quickly look at a range of design variable values, and see how they affect the design. 
Adams View gives you the option of displaying various plots, as well as a design study report. The design 
study report includes the design sensitivity of the pivot location, which is the rate of change of the spring force 
with respect to a change in the pivot location. 

To run a design study:
1. Click the Design Exploration tab on the Adams View ribbon.

2. From the Design Evaluation container, click Design Evaluation tool .

The Design Evaluation Tools dialog box appears.

3. Fill out the dialog box that appears so it matches the one shown here. Leave the dialog box open. 
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4. In the Design Evaluation Tools dialog box, select Display. 

The Solver Settings dialog box appears. 

5. To see all the options, select More.

6. Set Time Delay to 0.0.

7. Set Chart Variables and Show Report to Yes. 

8. In the Solver Settings dialog box, select Close.  

9. In the Design Evaluation Tools dialog box, select Start. 

Adams displays the following plots and a design study report:

 Spring force plot, with five curves for the five different cases:
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 SPRING_1_force versus DV_1 plot:

 DV_1 versus Trial plot:
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 overcenter_angle plot, with five curves for the five different cases:

 

 Design study report:
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10. Close the Information window, the Message window, and the Design Evaluation Tools dialog box.

Examining the Results of Design Studies
To save your time, we ran some design studies for all the design variables and provided the results in Table 1. 
These results are from individual design studies of each design variable, keeping the rest of the variables fixed 
at their nominal value. 

The results help you determine which design variables you should use for your optimization study, because 
they represent a summary of the sensitivity of the clamping force magnitude to a given change in the 
geometric location, keeping all other locations fixed.

Note:  Your results might vary slightly (about 1%) from those shown here due to 
computational differences.
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We found sensitivities by using the plot statistics function and finding the slope of the design study curve for 
spring force plotted against design variable value. 

Parameterization lets you see which design variables have the greatest effect on the clamping force. In this 
case, design variables DV_4, DV_6, and DV_8 have the greatest sensitivity.

Table 1  Design Studies Results

Design variable 
names:

Design point 
locations:

Initial 
value:

Sensitivity at initial 
value (N/cm):

Apparent optimal 
value:

DV_1 (POINT x) 0 -82 1

DV_2 (POINT y) 0 56 0

DV_3 (POINT_2 x) 3 142 2.7

DV_4 (POINT_2 y) 3 -440 3.3

DV_5 (POINT_3 x) 2 -23 2.2

DV_6 (POINT_3 y) 8 281 7.6

DV_7 (POINT_8 x) -1 36 -1.1

DV_8 (POINT_8 y) 10 -287 10.5

DV_9 (POINT_8_2 x) -6 -61 -5.4

DV_10  (POINT_8_2 y) 5 104 4.5
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Optimizing Your Design

Overview
You will now work on finding an optimal design that best meets the performance parameters, while satisfying 
the design constraints. Optimization involves determining which objective function you want to minimize 
or maximize, selecting the design variables you want to change, and specifying constraint functions that must 
be satisfied. 

Optimizing your design involves:

 Modifying Design Variables

 Running an Optimization

If you choose not to work through the tutorial in sequential order and want to work through it 
starting here, import the file refine.cmd from install_dir/aview/examples/Latch/, where 
install_dir is the directory where Adams is installed.

Modifying Design Variables
Use the design of experiments results shown in Table 1 of Iterating Your Design(those with the largest variable 
sensitivities) to determine which variables to use in optimization. Set up the optimization on design variables 
DV_4, DV_6, and DV_8, since they seem to have the most effect on the clamping force. Run the optimization 
with the set of parameters that would maximize spring force. 

To make sure that the model stays within a given work envelope, set the following limits on the design 
variables:

To modify design variables:
1. From the Model Browser window, click Design Variables and expand.

2. Select the first design variable you need to modify, in this case, DV_4 from the list. Right click and 
select Modify.

The Modify Design Variable dialog box appears:

Table 1  Design variable Limits

Design variable 
name:

Design point 
location:

Minimum 
value:

Maximum 
value:

DV_4 POINT_2 y 1 6
DV_6 POINT_3 y 6.5 10
DV_8 POINT_8 y 9 11
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3. Set the Min. Value and Max. Value, which are the minimum and maximum values for your first 
design variable, DV_4, as shown in Table 1.

4. Select Apply.

5. Right-click the Name text box, point to Variable, and Browse for DV_6.

6. Double-click on DV_6.

7. Type in the minimum and maximum values for DV_6. Make sure the Absolute Min and Max Values 
option is selected.

8. Select Apply.

9. Repeat the above three steps for DV_8.

10. After you have modified the last design variable, DV_8, select OK.

Running an Optimization
At this point you will run an optimization to find the best design configuration. Before you run an 
optimization, display the spring force measure. If you imported refine.cmd, the spring force measure will 
already be displayed.
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To display the spring force measure:
1. Click the Design Exploration tab on the Adams View ribbon.

2. From the Measures container, click Display a Measure tool . 

The Database Navigator appears.

3. Select SPRING_1_MEA_1.

4. Select OK.

The SPRING_1_MEA_1 plot appears.

To display the overcenter_angle:
1. Click the Design Exploration tab on the Adams View ribbon.

2. From the Measures container, click Display a Measure tool . 

The Database Navigator appears.

3. Select overcenter_angle.

4. Select OK.

5. The overcenter_angle plot appears.

To run an optimization:
1. Click the Design Exploration tab on the Adams View ribbon.

2. From the Design Evaluation container, click Design Evaluation tool .

The Design Evaluation Tools dialog box appears.

3. Fill in the dialog boxes as shown below and select Start after selecting Close from the two Solver 
Settings dialog boxes. 
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The spring force measure plot shows the optimal clamping force as a function of time. Note that the 
limits on the strip chart may be different if you worked through the entire tutorial or you loaded a 
command file and started from a particular chapter. 

Name of current model

Type of study to run

Use Measure, since you already have one 

Select Minimum of, because you need to 

List of variables to be changed in

Find optimal clamping force by  

optimization (DV_4, DV_6, and DV_8) 

Measure name

minimizing the spring force 

look at the maximum tension force on the
spring, which is negative

(largest negative value) 

to see all
options

Select More

Be sure to 
set this to
Database
Storage

Note:  The optimization may take several minutes to complete, and will take several 
iterations. Look in the status bar for status information.
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The SPRING_1_force versus iteration plot shows how the spring force changed with each iteration.

 

The overcenter_angle plot shows the cases in which the angle reached the toggle point.
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To see the final variable values and the optimized clamping force value:

1. At the bottom of the Design Evaluation Tools dialog box, select the Tabular Report tool .

The Design Evaluation Results Table dialog box appears.

2. In the Result Set text box, enter .Latch.Multi_Run_001.Optimization_Results.

3. Select OK. 

In the Information window that appears, you see all the data obtained from the optimization, 
including the initial and final values of the spring force and DV_4, DV_6, and DV_8.
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Automating the Design Process

Overview
In this chapter you work on meeting the last two design requirements for the latch: hand-actuated by less 
than 80.0 N force and hand released by less than 5.0 N of force. To do so, you quickly and interactively try 
out various handle force magnitudes by:

 Creating Design Variables

 Creating a Custom Dialog Box

 Modifying Force Values

 The Next Step

If you choose not to work through the tutorial in sequential order and would like to work through 
it starting here, import the file optimize.cmd from install_dir/aview/examples/Latch/, 
where install_dir is the directory where Adams is installed.

Creating Design Variables
To find the handle force values, you need to create two new design variables, DV_11 and DV_12. Use DV_11 
to set the clamping force, and DV_12 to set the release force.

To create design variables:
1. Click the Design Exploration tab on the Adams View ribbon.

2. From the Design Variable container, click Design Variable tool.

The Create Design Variable dialog box appears.

3. Set Standard Value at 80.

4. Set Value Range by to Absolute Min and Max Values.

5. Set the minimum value at 60, and the maximum at 90.

6. Select Apply.

7. Repeat for DV_12 setting the standard value to 10, the minimum value to 0, and the maximum to 
20.

8. Select OK.

Creating a Custom Dialog Box
You now create a custom dialog box to use in adjusting the downward force and the release force. You do this 
by:

 Adding Objects to Your Dialog Box

 Assigning Commands to the Sliders
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 Testing the Dialog Box

 Saving Your Dialog Box

To create a custom dialog box:
1. From the Tools menu, point to Dialog Box, and then select Create. 

The Dialog-Box Builder appears. 

2. From the Dialog Box menu, select New. 

The New Dialog Box appears. 

3. In the Name text box, enter Force_Control.

4. From the Create Buttons option, select OK and Close.

5. Select OK. 

Adams View displays your custom dialog box:

 

Adding Objects to Your Dialog Box
In this section you add two sliders to your dialog box and you label the sliders. The sliders let you set a value 
from a continuous range of possible values, as detailed in the next section. 

To add sliders to your dialog box:
1. Activate the Dialog-Box Builder.

2. From the Dialog-Box Builder Create menu, select Slider.

3. Inside your dialog box, click near the top center area of your dialog box, which is where the slider 
should appear, as shown in . 

4. Double-click on the slider to select it.

5. Drag the reshape handles to resize the slider.
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6. Create another slider underneath the first one.

7. Resize this slider to match the size of the first slider.

To label the sliders:
1. From the Dialog-Box Builder Create menu, select Label.

2. Inside your dialog box, click to the left of the first slider, which is where the label should appear, as 
shown in .

3. Double-click on the label, to select it. 

4. Set the Dialog-Box Builder Attributes option menu to Appearance.

5. Replace the contents of the Label Text text box, with Down Force Value.

6. Select Apply to make the change in your dialog box.

7. Use the reshape handles to resize your label.

8. Create another label, Up Force Value, to the left of the second slider.

Figure 1  Force Control Dialog Box

Reshape handles
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Assigning Commands to the Sliders
You can assign commands to the sliders you just created to perform the functions you need. 

To assign commands to the sliders:
1. Double-click the Down Force Value slider, and then from the Dialog-Box Builder Attributes pull-

down menu, select Commands.

2. At the bottom of the Dialog-Box Builder, select Execute commands while sliding. 

3. In the command window, enter variable modify variable=.Latch.DV_11 real=$slider_1.

The command sets the variable value of DV_11, the variable assigned to the down force value, to be 
equal to the slider selection.

4. Select Apply. 

5. From the Dialog-Box Builder Attributes option menu, select Value. 

6. Set the Value of the slider to 80, the Min. Value of the slider to 60, and the Max. Value to 90. 

This matches the range of values that was automatically set for DV_11 when you created it. If you 
want to open up the range to different values, you need to first modify the set of allowable values for 
the design variable.

7. Select Apply.

8. Repeat the above seven steps for the Up Force Value slider, replacing the command for this slider with 
variable modify variable=.Latch.DV_12 real=$slider_2.

Make sure you use the numerical values you assigned when creating the design variable used for this 
slider (Value = 10, Min. Value = 0, Max. Value = 20).

9. Select Apply.

Testing the Dialog Box
Use the Test Box command to keep the Dialog-Box Builder open and operational in test mode. When the 
dialog box is in test mode you can issue commands from it, but you can also quickly go back to edit mode 
by selecting Test Box again or double-clicking on the dialog box background.

To test the dialog box:
 From the Dialog-Box Builder Options menu, select Test Box.

Saving Your Dialog Box
Save your dialog box in a command file. In Adams View, a command file is simply a file that contains a set 
of Adams View commands. Even if you don’t save your dialog box to a separate command file, you can still 
access it through the Database Navigator. 
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To save your dialog box:
1. To enter edit mode, double-click on your dialog box background.

2. From the Dialog-Box Builder, select Dialog Box, point to Export, and then select Command File.

Your dialog box is saved in the command file Force_Control.cmd in the current working 
directory.

Modifying Force Values
You now modify the clamping and release force values to find the optimal force magnitude. You also plot the 
force values to see at what point the handle comes down to rest on top of the hook and when the 
overcenter_angle measure drops slightly below zero, creating a toggle force.

You can try different settings for the clamping and release forces to verify that the handle can be closed and 
released per the requirements.

To modify the clamping and release force values:
1. From the Model Browser window, click Forces and expand. 

2. Select Force:SFORCE_1 from the list, right click and select Modify.

The Modify Force dialog box appears. 

3. Next to the Function text box, select the More tool .

The Function Builder appears.

4. Clear the function text area located at the top of the Function Builder.

5. In the function text area, enter the STEP function as shown next:

Notes:  If the sensor is causing problems with the investigation, you can deactivate it:

Click the background to ensure that nothing is selected.

 From the Edit menu, select Deactivate.

 The Database Navigator appears.

 From the Database Navigator, select the sensor.
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6. Select Apply.

Plotting the force values:
1. From the Function Builder, select Plot Limits.

The Function Builder Plot Limits dialog box appears.

2. Change the End Value to 0.2.

3. Select OK.

4. Select Plot.

The Function Builder Measure plot displays the force function. This is the handle force you apply to 
the latch. The Down Force Value slider sets the clamping force. The Up Force Value slider sets the 
release force.
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The Next Step
You have now finished designing the latch model to meet the design requirements, without first having to 
build a physical prototype. For more information about using Adams View, see the Adams View online help.
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